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1.1 About Wink™ 
 
Wink is a software tool to make presentations and tutorials about using software 
programs. A Wink presentation will resemble a live walkthrough about how to use the 
software. Also the author of the presentation can add comments and explanations to 
parts of the presentation to better explain the concepts and usage to the end user. 
 
There are many purposes for these kinds of presentations: 

• Advertising of software. 
• Tutorials of software for classes. 
• Documentation of software to supplement written documentation. 
• Answer questions about the use of programs visually. 

 
The basic output format of Wink is Flash. Flash is viewed in a web browser using the 
free Macromedia Flash Player which is already installed on most computers or can 
easily be installed the first the time the end user tries to watch a flash file. 
 
Wink is actively in development and constantly improving. If you have a comment or 
suggestion to make or an idea to improve, please make it public by posting in the 
UserForums at "http://www.debugmode.com/forums/". 
 

1.2 Requirements 
 
When working inside Wink the minimum screen resolution to be used should be 
800*600 although it is recommended to use a screen resolution of 1024*768 or 
better. This will make it easier to edit a presentation with a large area size because 
you will be able to see full or at least a larger part of the current frame. 
 
The minimum and recommended screen resolution doesn't apply when you are 
capturing screenshots for a Wink presentation. Screenshots could very well be 
captured with a screen resolution of 640*480 depending on the needs. 
 

1.3 Installation 
 
The installation package comes as a zip file with the install file. Unzip this file into any 
temporary folder and run "setup.exe" to start the installation. If you have an earlier 
version of Wink installed, this installation may overwrite the settings of the earlier 
install (similar to an upgrade). 
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1.4 New features in version 1.5 
 
Wink has been completely rewritten in version 1.5 and native versions for both 
Windows and Linux are available. The Linux version may be available now online, 
and if not will be available some soon. The following is a list of the most important 
new features in Wink 1.5 among many improvements, changes and bug fixes. 

 
• Multilingual support 
• Add control bar to flash output  
• Add preloader to flash output 
• Automatic input-driven capture of screenshots 
• Improved design of callouts 
• Inline editing of text in callouts 
• Improved callout chooser and callout editor 
• Resize frames 
• Improved way to define capture area 
• Export/import the content of all textboxes and titles in a project 
• Export a Wink project as a PostScript (*.ps) file 
• Replaced cursor editor with an option to import/export cursors 
• Play audio tone when capturing screenshots 
• Customize screen capture hotkeys 
• New palette creation method (Histogram + Optimized Octree) 

 

1.5 Differences between Windows and Linux versions 
 
Most of the Wink user interface and features are the same in Windows and Linux, but 
there are a few differences. The key ones are listed below. 
 

• No input-driven capture mode in Linux 
• Text fonts in Windows and Linux will be different depending on what is 

available in the system 
• UI widgets will be different in both platforms so there will be minor differences 

in the functionalities 
• Wink system tray icon in Linux will be available only if the window manager 

supports the required extension 
 

1.6 Using this guide 
 
This user guide is distributed as a PDF document so that it can be printed as a 
manual if necessary. It is recommended that you read this document completely 
before starting to use Wink so that you can work with ease. Also a printout of the 
shortcut keys will be helpful. 
 
Two tutorial projects are present in this distribution. Once installed, run Wink and 
choose menu "Help > View tutorial 1". Answer Yes to render the tutorial. You will see 
the tutorial right after the rendering is done. 
 
The sample projects are named "tutorial.wnk" and "sample.wnk". These files are 
present in the Wink\Samples folder. There is also a step-by-step tutorial later in this 
document. 
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2.1 How to use Wink 
 
To create a new presentation in Wink you run your target software and take 
screenshots with Wink (automatically and/or manually) of each action done in that 
software. These screenshots will afterwards be put together by Wink into a 
continuous movie in which each screenshot represents a frame. Frames can be 
moved, deleted and copied inside the project and between projects. 
 
The mouse cursor’s position is saved separately for each frame. This way Wink will 
take care of making the cursor move smoothly between frames. You can also change 
the position of the mouse cursor in any frame. 
 
There are several advantages to record presentations using screenshots and not 
recording the entire presentation as a single movie: 
 

• It is easier to capture screenshots because if you make mistakes (open the 
wrong file, do the wrong action, forget what to do and thereby making a long 
pause etc.) in the recording progress you just don't take screenshots of these 
errors. If you were recording a continuous file you would have to be very 
prepared in advance to avoid these kinds of recording mistakes. 

• When editing the file afterwards there are fewer frames to work with and most 
frames are important - that is to say that there are only few or none 
intermediate frames that for instance just show the mouse cursor moving from 
one place to another. 

• The resulting flash file will also be smaller because there are fewer frames in 
the presentation. 

 
But in some cases it can be useful and easier to just record everything that happens 
e.g. when drawing or typing text in a program. In this case Wink can be set to either 
record continuously through timed capture with a certain frame rate or use input-
driven capture where screenshots will be captured each time you click with the 
mouse and/or press a key. 
 
After the recording is done you can edit the sequence of frames and add 
comments/explanations to each frame as necessary. You can add Previous and 
Next buttons to pause the presentation and the user can then go back and forward in 
the presentation by clicking these buttons. You can also add two Goto buttons that 
jumps to other sections in the presentation. These help to create more advanced 
presentations with different flows through the content instead of just going from start 
to finish. 
 
 
 

2 BBAASSIICCSS  
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You can customize/personalize the presentation by choosing a static background 
image for the entire presentation. This can contain the name, logo, copyright 
messages etc. of the author and/or company. 
 
In order to make consistent presentations you can create templates based on one 
presentation and then apply this template to all other presentations. This way it is 
easy to get the same look across presentations and you don’t have to do the same 
customizations each time. 
 
Once you have finished creating and editing a presentation, it must be rendered to a 
flash file that for instance can be placed on a website or distributed in other ways for 
the end users/customers to see. The quality and size of the presentation can be 
adjusted through the number of colours used and the chosen frame rate of the flash 
file. It is also possible to add both a preloader and control bar to the rendered 
presentation. A preloader will be shown when the presentation is loading while the 
control bar shows the progress of the actual presentation and makes it possible to 
pause at will. 
 
The presentation can be exported to a HTML, PDF or PostScript file. These exported 
files can be placed together with the rendered flash file on a website and the end 
user will then have the option to print the presentation. Each frame in the 
presentation will become a single image with the comments/explanations and buttons 
that have been added in Wink. All buttons will still work in the exported files and will 
jump to the corresponding place (HTML) or page (PDF, PostScript) in the file when 
clicked.  
 

2.2 Your first Wink project step-by-step 
 
This section will guide you through the process of making your first Wink project. We 
will make a short presentation that shows how to change the file view in Windows 
Explorer from icons to details. You can also find a Wink project for this tutorial named 
“tutorial.wnk” in the folder ”Wink\Samples”. 
 
1. Preparing Windows Explorer and Wink for capturing. 
 

1.1. Open Windows Explorer because this is the program we want to show in the 
presentation.  

1.2. Start Wink and create a new project using the menu “File � New”. This 
brings up a wizard that by default sets Wink to capture screenshots of the 
entire screen. One of the options in this step is to change the capture region 
to a specific window or part of the screen (rectangle). For this project we will 
capture the region of the Explorer window so choose the window option. 

1.3. Click the ”Hide Wink Window” checkbox to make the Explorer window visible. 
1.4. Click the “Choose” button, move the mouse to the title bar of Windows 

Explorer and left click to select this window. 
1.5. Press OK. 

 
2. Minimize Wink to the system tray (the bottom right corner of screen) by clicking 

“Minimize to Tray” and we can now take screenshots by pressing the default 
"Pause" key. Each time you take a screenshot the Wink icon in the system tray 
will blink. You can also activate input-driven capture (Alt + Shift + Pause by 
default) to make Wink automatically capture screenshots for each mouse click 
and key press. When using this option you rarely have to think about taking 
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screenshots yourself and the project will typically also end up containing a few 
more frames than if you captured manually because more details are recorded. 

 
3. Take screenshots after each of the following actions in Windows Explorer or just 

do the actions if using input-driven capture: 
 

3.1 Minimize all windows except Windows Explorer. Place the mouse cursor 
somewhere in Windows Explorer. Take a screenshot. 

 
3.2 Move the mouse cursor to the “View” menu in Explorer. Take a screenshot. 
 
3.3 Open the menu by left clicking. Take a screenshot. 
 
3.4 Move the mouse cursor to the “Details” menu option. Take a screenshot. 
 
3.5 Click the mouse to select the Details option. This changes the view to details 

view. Take a screenshot. 
 

4. Now we have finished capturing frames so right click on the Wink icon in the 
system tray and choose "Finish Capture". 

 
5. Wink will now display the current project. The larger top part of the window shows 

the last frame in the sequence. In the bottom you can see all frames in the 
sequence/presentation. The captured mouse cursor is visible with a box around it 
to easily identify it from the real cursor. In the other frames you will be able to see 
the progress of the presentation and the movement of the cursor. 

 
6. First we will add a textbox to the first frame explaining what this presentation 

shows. The textbox displays text in a popup balloon-like element called the 
Callout. A Callout is a group of shapes created using the built-in Callout Editor. 
Wink comes with many pre-defined callouts you can choose between for the 
textboxes used in frames, and you can create your own callouts using the Callout 
Editor. 

 
7. Select the first frame in the thumbnail list shown at the bottom of the window. 

Now go to the Properties bar (the bar on the right of the Wink window) and 
enable the checkbox named Textbox. The textbox will be displayed with a default 
(the last used) callout in the frame. You can now double click the textbox in the 
frame and type the text (something like "How to change file view in Windows 
Explorer") inside it. You can resize the callout in the frame, move it to another 
position, choose another callout by clicking the button showing a speech bubble 
and edit the font by clicking the button showing an F. 

 
8. Now we will add a Next button that the end user can use to start the presentation 

and a Goto button to return to the start from the last frame (in this simple 
presentation a back button would also return to the first frame). Select the first 
frame in the sequence and click the checkbox for the Next Button in the 
properties bar. The button is by default placed in the bottom right corner but it can 
be moved to any place you desire. 

 
9. Select the last frame and click the checkbox for “Goto Button 1”. Then click the 

choose button next to the checkbox (or double click the actual goto button in the 
frame) to select the frame it should go to. In this case it should be frame 1. Goto 
buttons are by default placed in the top left corner but can also be moved 
anywhere in the frame. You can move this Goto button to the center of the frame 
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area. 
 
 
10. To tell the end user what this Goto button does, we will add a textbox to this 

frame with the text “Replay presentation”. The text box and the Goto button 
should be placed so that the button is inside the text box area either to the right of 
or below the actual text. 

 
11. Before going further we will save the project using the menu ”File � Save”. You 

should save your project often when editing the project. 
 
12. Choose menu ”Project � Settings”. Type the name for the output flash file (for 

instance "Explorer_views"). If you just specify a filename, the output flash file will 
be saved in the folder where the project is saved (or the desktop if you haven’t 
saved the project yet). Press OK when you have typed a name. 

 
13. Choose menu ”Project � Render” or press the green arrow in the toolbar to 

create the presentation as a Flash file. 
 

14. Congratulations - you have made your first Wink presentation. You can view it 
through “Project � View Rendered Output”. This will open your browser and you 
should see the presentation being displayed or if you do not have Macromedia 
Flash Player installed you would get an option to install it. 

 
15. In the folder where the flash file was generated/saved you will see that besides 

the actual flash file Wink also generates a HTML file with the same name to open 
the flash file in the correct size. When putting a presentation on a webpage you 
should link to the HTML file and not directly to the flash (swf) file. 

 
You have now seen and tried some of the options in Wink. Continue reading the next 
chapter to get more information about the user interface and options in Wink to 
improve your skills in making great Wink presentations. 
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3.1 Basic UI 
 
When you first start Wink you will see a menu and a toolbar at the top of the window. 
To the right is the Properties bar where individual and common properties for all 
frames are accessible. The properties bar can be changed between a simple 
(default) and an advanced view through the menu “View � Properties Bar”. The 
difference between simple and advanced view is that in advanced view it is possible 
to see and edit the exact position of all elements added to a frame. 
 
The language used in the user interface can be changed from the menu “File � 
Choose Language”.  
 

 
 

The project window is divided into two parts: 
 

• In the work area at the top you see the currently chosen frame in normal size 
and the elements that are added to the frame can be moved and resized with 
the mouse. 

• The thumbnail list at the bottom shows thumbnails of all the frames in the 
current project. You can drag-and-drop frames within this list or between 
projects and select which frame you want to edit in the work area. 

 
More than one project can be open simultaneously in Wink, which makes it possible 
copy frames between projects.  

3 UUSSEERR  IINNTTEERRFFAACCEE  
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3.2 New Project Wizard and capturing screenshots 
 
3.2.1 Step 1 - Setting up the project 
 
When creating a new project you will see the "New Project Wizard" with options to 
start capturing screenshots or just create an empty project.  
 
Normally you would want to capture screenshots for the new project through Wink. If 
you just want an empty project you must uncheck the "Start by capturing 
Screenshots" option. An empty project is useful if you want to copy frames from other 
existing projects or if you already have captured screenshots as single images with 
another program and now want to use them in a Wink project.  
 

  
 
When capturing screenshots with Wink there are 3 ways to specify the capture area: 
 

• Screen: The entire area of the screen. 
• Window: Use the Choose button and a rectangle will show the area of the 

window/program being captured. If you want to capture an entire window you 
should move the mouse cursor to the window’s title line. 

• Rectangle: Use the Choose button to draw a rectangle around the area that 
must be captured or use one of the supplied default sizes. 

 
To easily identify the area that should be captured for the project you can click the 
"Hide Wink Window" checkbox. (This will not hide the New Project Wizard dialog.) 
After defining a capture area (except the entire screen) you can still easily adjust the 
chosen area by dragging the green borders identifying the area or by editing the 
region values in the dialog. 
 
At the bottom of this dialog you can change settings for the two automatic capture 
modes. For timed capture it is possible to define how often captures should be made. 
This can be a rate of a number of frames per second, minute or hour. Regarding 
input-driven capture this can be set to capture screenshots at all mouse clicks and/or 
all key presses. 
 
Press OK to go to Step 2 of the New Project Wizard (if you have chosen to capture 
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screenshots). If you deselected the checkbox for "Start by capturing Screenshots" 
you will be brought back to Wink and see an empty project. 
 
3.2.2 Step 2 - Capturing screenshots 
 
Wink is now in capture mode. You can see the hotkeys available to either capture 
screenshots manually or start/stop one of the two automatic capture modes. In the 
bottom of the dialog you can see how many frames have been captured until now. 
 

  
 
In most cases you would now want to minimize Wink to the system tray so that Wink 
itself isn't visible in the screenshots. 
  
When minimized Wink is shown as an icon in the system tray. You can right click this 
icon to capture a screenshot, finish the capture session, cancel the capture session 
or restore the capture window (to see how many frames have been captured). 
 
There are 3 different way to capture screenshots for a project and you can change 
between them in the same capture session. 
 

 Manual screen snapshots – Each time you press the hotkey (default: 
Pause) the current content of the screen is captured to a frame in the 
project. The Wink icon in the system tray will blink momentarily to indicate 
this. If you want to use this mode exclusively you have to take 
screenshots after all actions done with the mouse and keyboard and 
furthermore also each time the mouse cursor has moved from one 
position to another. 
 

 Timed capture – When activated with the hotkey (default: Shift + Pause) 
Wink will continuously capture screenshots with a certain capture rate that 
is specified in the previous step until you stop it again with the same 
hotkey. The Wink icon will be replaced by an animation that updates with 
the speed of the capture rate. For tutorials it is not very efficient to only 
use this mode because it will quite certain record many unnecessary 
frames but it can be effective for small parts of a project showing for 
instance how to draw in a program. This mode is also useful for tracking 
the behaviour of programs/installations that runs for a long time. In this 
case you could set the capture rate in the previous step to only record a 
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given number of frames per minute or hour instead of frames per second. 
 

 Input-driven capture – Using input-driven capture Wink will automatically 
try to capture all the relevant frames while you do the actions that should 
be recorded. It can record all mouse clicks and/or all key presses (with the 
exception of some default and user-defined key combinations) based on 
the choice in the first step of the wizard. This mode is started and stopped 
through a third hotkey (default: Alt + Shift + Pause) and the icon in the 
system tray will change to show when it is activated. Like with manual 
screen snapshots the icon will blink each time Wink captures a screenshot 
but in this case not all the screenshots are actually converted into frames 
in the project since Wink will only save a screenshot if it is different from 
the last one. 

 
When using input-driven or timed capture mode, you can force captures at any time 
using the manual screenshot hotkey. 
 
When you have finished capturing screenshots you must right click the Wink icon in 
the system tray and choose Finish (or Restore Capture Window and press the Finish 
button here). This will end the capture session and you will see the project window. It 
will take a little while to generate all the thumbnails depending on the number of 
frames and the speed of your computer. 
 
If you choose to cancel the capture session no new project is created and all 
captured screenshots will be lost. 

3.3 Project Settings 
 
Project Settings can be opened through the menu “Project � Settings”. In the first 
field you must specify the name of the output flash file to create when you render the 
project. If only a file name is specified the file will be created in the folder of the 
project file (or the desktop if you haven’t saved the project yet). 
 

 
 
Output file type can be Macromedia Flash (.swf) to show on web pages, or a self-
playing Flash executable (.exe) that you can view directly on any PC. 
 
Frame Rate determines the speed of the presentation in frames per second. This 
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setting is highly related with the Cursor Movement setting. So if you want smoother 
cursor movement and move the slider to the left you will also have to increase the 
frame rate to make the mouse cursor have the same speed in the final presentation 
as the original setting. For a more thorough explanation see the gray box below. 
 
The last option specifies if the project should use a Palette when generating the flash 
file. Without using a palette the presentation will use all the colours seen in the 
individual frames. By adding a palette Wink reduces the total number of colours used 
throughout the presentation to a maximum of 256 colours. (You can define the 
number of colours in a palette to be between 1 and 256 colours.) 
 
The purpose of reducing the number of colours is to reduce the file size of the 
rendered flash file. Dependent on the number of colours in the frames you might not 
be able to see any difference in the rendered presentation than if not using a palette. 
If there are photos or gradients between colours in any frames the effect of using a 
palette will be more visible in the presentation. The creation of the actual palette is 
shown in the next section. 
 

The connection between Frame rate and Mouse Cursor Movement 

If the mouse cursor moves from one position to another between two frames, Wink will 
generate intermediate frames while rendering to show the cursor movement. A more smooth 
Cursor Movement setting will generate more intermediate frames. But if we add more 
intermediate frames and don't increase the frame rate correspondingly the movement of the 
cursor in the flash file will also be slower. 
 
For instance if Wink normally generates 16 intermediate frames between 2 frames in the 
project and we use the default frame rate of 8 frames per second it will take 2 seconds for the 
cursor to move from the start position to the end position. If we now change the Cursor 
Movement to be smoother Wink may now generate 32 intermediate frames between the 2 
original frames. With the default frame rate of 8 frames per second it will now take 4 seconds 
for the cursor to move from the start position to the end position. If we want the final 
presentation to keep the same speed as with the original smoothness setting we will have to 
change the frame rate to be 16 frames per second instead. 
 
This relation is described in the following formula: 
 
Frame rate / Smoothness of cursor movement = Speed of mouse cursor in presentation 
 
Higher frame rate � Faster mouse cursor 
More smooth cursor movement � Slower mouse cursor 

3.4 Palette 
 
If you have chosen to use a palette in the Project Settings you can create or edit a 
current palette by choosing menu “Project � Edit Palette”. Also if you have chosen to 
use a palette but have not created one before rendering you will be shown this 
dialog. For best results postpone the palette creation until all editing in the project is 
done. 
 
The first time you will see an empty palette. You can actually change the number of 
entries and choose each colour manually but that is not recommended. Click the 
"Create New" button and let Wink create the palette from one of 4 methods. 

 
• Histogram + Optimized Octree: This is the recommended setting to use as it 
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normally gives the best result for the rendered output. ¼ of the palette is filled 
with the most frequently used colours in the frames (using a histogram) while 
the rest of the palette is based on an optimized octree calculation. 

• Optimized Octree: With this setting the entire palette is based on an optimized 
octree calculation and the result is normally also very good but sometimes 
there can be problems with frequently used colours in the rendered output. 

• Web-Safe 216 colours: Standard colours used and supported by all browsers 
and web tools. 

• Windows Standard 16 colours: If you want to support old systems that can 
only show 16 colours. 

 

 
 
For both “Histogram + Optimized Octree” and “Optimized Octree” you can choose 
how many colour entries there should be in the palette. The default setting of 256 
entries and the option to use all frames should be the best setting in almost any case.  
 
When the palette is created you can edit the individual colours by double clicking 
them. You can also save and load palettes. This can be useful if you are trying to see 
the effect of different palettes in the rendered presentation. 

3.5 Editing frames in a project 
 
Most of the time spend in Wink will be 
used to edit frames in the project i.e. 
adding/removing elements to the frames.  
 
Almost all options regarding this are 
available in the properties bar (Some are 
also available in the menus and a few are 
only available through the menus). The 
properties bar can be displayed in a 
simple or advanced mode through the 
menu “View � Properties Bar”. In 
advanced view it is possible to see and 
edit the exact position of all elements 
added to a frame. Advanced view also 
enables you to edit/align the position of 
elements across multiple frames at once. 
See the Tips and Tweaks chapter on how 
to achieve this.  
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3.5.1 Frame Titles 
 
Frame titles are used to display a title/headline for individual frames. They can be 
enabled for all frames using the checkbox in the common properties section of the 
properties bar. You can change the font used for titles using the choose font button 
(F) and alignment of the titles using the alignment button (next to the choose font 
button). 
 
The actual title for the current frame is typed in the Title field at the top of the 
properties bar. By default the field for the frame title field is placed in the top left area 
of the frame (50 pixels to the right and 50 pixels down from the top left corner) but 
you can move and resize it as needed. Titles appear in the same position in all 
frames. 
 
If you haven't typed a title for the current frame you will see the text: ”The frame's title 
will come here...”. This default text will not be displayed in the rendered flash file. 
 
3.5.2 Stay in this frame for time 
 
This field is used to add a pause for some time before showing the next frame. When 
adding small pauses between frames it gives the end user a little more time to 
comprehend what is being shown in a presentation and it can also be useful to make 
the presentation look more real. The pause is specified in milliseconds so a value of 
1500 means 1.5 seconds. 
 
3.5.3 Cursor 
 
When capturing screenshots using Wink the mouse cursor is displayed in the correct 
position for the individual frames. To make it easy to separate the actual mouse 
cursor from the cursor in the frame the latter is surrounded by a little box. You can 
move the cursor anywhere and enable / disable it, as you need. 
You can change the cursor image in a frame using the choose button to the right of 
the cursor option in the properties bar. Here you will be able to choose from all the 
pointers in the currently used pointer scheme (This can be changed in Windows 
Control Panel) and user defined pointers. 
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You can export existing cursors to png images and import new cursor from icon 
(*.ico) and cursor files (*.cur) or gif and png images. 
 
3.5.4 Next/Previous Buttons 
 
When a Next and/or Previous button is displayed in a frame the presentation will 
pause and the user has to click one of the buttons to continue. This gives control to 
the users and enables them to go through a presentation at their own pace. 
 
A Next button will continue directly to the next frame in the sequence while a Back 
button will go back to the previous frame with any type of button. 
 
Like the other elements in a frame you can enable/disable each type of button by 
clicking their checkboxes in the properties bar and by default they are placed in the 
bottom right corner of the frame. They can be moved by dragging them around in the 
frame or by editing their position values in the advanced properties bar. The buttons 
can be placed in different positions on each frame. 
 
You can use your own images for the buttons by clicking the second (Next) and third 
(Previous) button at the bottom of the properties bar (or through the Project menu) to 
change the images. A lot of formats are supported for the buttons including PNG 
images and icons where you can have transparent areas with full alpha channel to 
enable the use of cool looking buttons. 
 
Each button can only have one image that is common for all frames. 
 
3.5.5 Goto Button 1 and 2 
 
The two Goto Buttons can be seen as general-purpose versions of the Next/Previous 
Buttons and you decide which frame the Goto Buttons should jump to. This enables 
the creation of more complex flows though a presentation than just a linear flow from 
start to finish. 
 
If you are showing two ways to do a particular action in your presentation, you can 
capture screenshots of both ways and give the end user the option to choose which 
way he/she wants to see. 
 
Another use would be if there is both some basic knowledge and more advanced 
knowledge in a presentation. Here it would be possible to make the option to jump 
directly to the advanced knowledge if the user already knows the basic stuff.  
 
Finally when reaching the end of a presentation it would be obvious to create a Goto 
button that goes back to the first frame and in this way becomes a restart button. 
 
Each time you use a Goto button it is recommended that you refer to it from a textbox 
to tell the end user what it does. See examples of this in the included tutorial files. 
 
When adding a Goto button by clicking the relevant checkbox it will by default be 
placed at the top left corner where you can move it to the correct place. You tell it 
what frame to go to by double clicking the actual goto button, clicking the choose 
button next to the chosen Goto Button in the properties bar or through the Image 
menu and select the correct frame. 
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When you decide to move some of the frames in a project to another place in the 
sequence of frames Wink will make sure that Goto buttons always points to the same 
frames (by content not number) that you decided from the start. If you delete the 
frame that a Goto button points to then the Goto button will also be deleted. 
 
Like with the Next/Previous Buttons mentioned above you can also change the 
(common across all frames) image used by each Goto button. You do this by clicking 
the fourth (Goto 1) and fifth (Goto 2) button at the bottom of the properties bar or 
through the Project menu. 
 
3.5.6 Textbox 
 
Textboxes are often the most important element in a presentation because it is 
through these you increase value by adding comments and explanations to the 
content in the individual frames. 
 
A textbox consists of a callout and the actual text. The callout is the graphical 
element the text is placed inside and it can be anything from a plain rectangle to 
fancy speech bubbles. A number of standard callouts are supplied with Wink but it is 
also possible to design your own callouts with the Callout Editor available from the 
Callout Chooser. 
You can add/remove a textbox in a frame by clicking the checkbox in the Properties 
Bar. A new textbox uses the same callout that was used last time. The textbox can 
be moved and resized using the mouse or by editing the position values in the 
advanced properties bar. 
 
To add/edit text in a textbox you can either double click it in the frame or click the first 
button regarding textbox in the properties bar. When editing a textbox a toolbar will 
be shown right above the text area allowing you to easily change font, font size, font 
colour and if the text should be bold, italic or underlined. Each of these options 
always works for the entire text in a textbox. Clicking outside the textbox after editing 
or clicking the diskette in the toolbar keeps the changes made while clicking the red 
X will undo changes in the textbox. If you have added more text than can fit in the 
textbox Wink will automatically resize it when you decide to keep the changes. 
 
Besides changing the font used while editing the content of a textbox you can also 
change it by using the choose font button (F) in the properties bar (or Choose Callout 
Font in the Image menu). Finally the alignment of the text in the textbox can be 
altered through the text align button in the properties bar. 
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You can change the callout using the button showing a speech bubble in the 
properties bar (or Choose Callout in the Image menu). This opens the Callout 
Chooser where you can choose between the available callouts and see a preview of 
them. This dialog also allows you to create new and edit existing callouts using the 
Callout Editor described in the next section. Furthermore you can create copies of 
and delete existing callouts. The folder tree the callouts appear in is defined through 
the naming of each callout where dots ‘.’ splits the name into folders subfolders and 
the actual callout. So for instance the name “3D Box With Arrow.Yellow.Left” first 
creates a folder named “3D Box With Arrow”, under this you will find a subfolder 
called “Yellow” and finally the actual callout is called “Left”. The <Legacy Items> 
folder contains callouts to support wink projects created in version 1.0. 
 

 
 
Textboxes can be copied between frames but if you paste in a frame, which already 
has a textbox, the existing one will be replaced with the new properties. 
 
You should accompany textboxes with either Next/Previous (and/or Goto) buttons to 
pause the presentation or add a large value (many seconds) in the ”Stay in this frame 
for time” field. Actually if ”Stay in this frame for time” is set to zero Wink will 
automatically add the Next and Previous buttons to the frame when you add a 
textbox and also remove these buttons when you decide to remove a textbox. 
 
3.5.7 Callout Editor 
 
The Callout Editor is accessible from the Callout Chooser when you click either the 
Edit button to alter an existing callout or Create New to make a new callout from 
scratch. This is a somewhat advanced tool to design your own callouts. It might take 
a little while to grasp the Callout Editor but when you have learned how to use it you 
can make all kinds of fancy looking callouts. 
 
The Callout Editor consists of a toolbar at the top, a work area at the left and a 
properties bar at the right. At the top of the properties bar you can see a list of all the 
shapes in the callout you are editing. When you select a shape in this list it will also 
be selected in the work area and you can see the properties of the shape below the 
list and modify them. Shapes can also be selected directly in the work area. 

 



 20 

 
 
To draw new callouts Wink provides 4 different tools. 
 

 Rectangle - To create a rectangle shape click on a place in the work area, 
drag the mouse and release the mouse button in the second position. 

 Ellipse - Drawing an ellipse is similar to drawing a rectangle. 
 Polyline - Using this tool you can create a shape by drawing a set of 

connected lines. To start drawing click a place in the work area and the 
first line starts. Move the mouse to the second position and click, this will 
end the first line and start the second line from this position. Do this 
repeatedly until you have created the entire shape. To finish drawing the 
shape, click the right mouse button. 

 Curve - This tool allows drawing any kind of shape and creating the shape 
as a curve. You can modify this curve later as you want. To draw a curve 
shape click on a place in the work area and draw the full Shape while 
keeping the mouse button pressed, and release the button after you have 
finished drawing. 

 
Each shape has properties regarding line width, line colour and fill colour. Fill colour 
is by default a single colour but clicking a checkbox can change this to be a gradient 
instead. For gradients there is a start and an end colour and through the gradient 
direction values you can change both the direction and how dominant each colour 
should be. The percentage value behind each colour determines the transparency so 
it can be made possible to see some of the other shapes behind the current shape. 
The Closed checkbox determines if the line that makes up the shape should be 
continuous – that is if the start and end point of the line are connected. 
The shapes will be added to the list in the order they are added to the callout. This 
order is important to get the correct effects. Latter shapes in the list are drawn on top 
of earlier shapes in the work area. 
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The last shape (Text Field) in the list is special since it is only used to specify where 
text can be written inside the callout. The only thing you do to this shape is to change 
its position and size in the callout. It cannot be deleted. The default colour of the text 
can also be set right below the shape list. This colour is overridden if you choose 
another colour in the font dialog for the individual textboxes. 
 
The Intelligent Resize option deals with making sure that a callout still looks good 
when resized to other sizes than how it was originally created. Basically without this 
option there will often be problems with any callouts that is not a basic rectangle 
because the corners and ornaments that are added to a callout will be resized along 
with the size of the textbox. When Intelligent Resize is activated Wink will do the best 
it can to preserve the look of the edges, corners etc. when the textbox is resized. 
 
There are two types of shapes: shapes created with lines and shapes created with 
curves. Polyline and rectangle are shapes created with lines while ellipse and curves 
are (Bezier) curves. A line-based shape has end-points, whereas a curve shape has 
control-points. 
 
Wink provides six tools to modify the shapes. 
 

 Edit - This tool allows editing a shape at the basic level, by modifying the 
points of the shape. If the shape is a line shape (i.e. a polyline or a 
rectangle), you can edit the end-points of each line. If the shape is a curve 
(ellipse and curve), you can edit the control points of the curve. You can 
add new and delete old points on a shape by right clicking an existing 
point on the shape and choose the options from the menu. 

 Transform - This tool can move and resize a single shape at a time. Just 
select the shape you want to edit, and use the frame around the shape to 
move and resize it. 

 Rotate left - Rotates the selected shape 90 degrees counter clockwise. 
 Rotate right - Rotates the selected shape 90 degrees clockwise. 
 Mirror - Mirrors the selected shape.  
 Flip - Flips the selected shape.  

 
Finally the Callout Editor has some basic tools to undo/redo the last actions, the 
options to delete, cut, copy and paste the shapes in a callout plus the choice to zoom 
in and out on the work area. 
 
3.5.8 Background Image/Colour 
 
The purpose of adding a background image or background colour is to further 
customize the presentation to your needs. You can have a logo, name or copyright 
notice showing all through the presentation or add a background that looks like a TV 
set and use Next/Previous buttons as the TV's controls while showing the actual 
presentation on the screen. 
 
A background image or colour is added to the presentation using the button at the 
bottom left of the properties bar or through the menu “Project � Choose Background 
Image”. You can choose between a simple solid background colour or load an image 
file created in another program. 
 
When using a simple colour background you must specify how large the background 
area must be and the fill colour. The size of the background area must be at least the 
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size of the frame images in the project. Information about the size of the frame 
images can be seen in the status bar at the bottom right of the Wink window or be 
found through the menu “Project � Information”. 
 
After having added a background image/colour you will notice that the frame 
images/screenshots by default is placed at the top left corner of the background 
image/colour. To change this position you can drag the frame image by its border or 
edit the Frame Position values in the advanced properties bar. 
 
If you want to remove a background image/colour from a project you just have to 
uncheck the checkbox for this option in the properties bar. Be aware that this 
removes the background from the project and does not just disable it. If you want the 
background back at a later time you have to choose the colour or load the original 
image again in the Choose Background Image dialog. 
 
3.5.9 Shift All Elements 
 
If all elements in all frames have to be moved to another position use the “Project � 
Shift All Elements” dialog. You specify by how many pixels all elements (including the 
frame image/screenshot) have to be moved. You can enter negative values if you 
want to shift elements upwards or to the left. This option is only available when a 
background image/colour is used in the project. 
 
3.5.10 Crop All Frames 
 
Crop means you remove part of all frames in the current project e.g. if you have 
created a project based on screenshots of the entire screen, you might want to 
remove the bottom part showing the taskbar. Use the “Project � Crop Frames” 
dialog for this purpose. 
 
The dialog displays the current size of frames in the project and you must then 
specify the area to which you want to crop the frames. If you use a background 
image/colour in the project Crop Frames won’t affect the background but only the 
frame images/screenshots. 
 
3.5.11 Resize All Frames 
 

 
 
This feature gives you 3 options on what to resize: 
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1. All elements in the project (with the exception of textboxes) 
2. Only frame and cursor 
3. Only frame 

 
You can enter either the percentage value or an exact pixel size for the new size. Be 
aware that this feature will give the presentation a slight blurred look because the 
sharpness of images will be lost when resized. 
 
3.5.12 Insert and delete frames 
 
New frames can be inserted in a project through the menu “Image � Insert Frames”. 
You can insert frames before or after the current frame and they can either be a copy 
of the current frame or blank frames (used to paste images/screenshots created by 
other programs). When inserting blank frames into an empty project you will be 
asked for the size of the frames to insert. 
 

 
 
You can delete selected frames using the delete key/icon or going through the menu 
“Edit � Delete”. 
 
3.5.13 Editing the sequence of frames 
 
You can use standard drag-and-drop, cut, copy and paste tools to work with the 
frames in the thumbnail list of the project.  
 
When you copy a frame in the thumbnail view, all the elements (frame, buttons, 
textbox, title etc.) are copied and when pasted it will create a new frame. 
 
There is another option called Copy Merged in the Edit menu. This will merge the 
frame and all elements into a single image. If you paste an image that has been 
created by the Copy Merge option this image will not create a new frame but the 
image will be inserted into the current frame and the elements will not be editable any 
more as they are a part of the image. The purpose of Copy Merge is to copy an 
entire frame with added elements to other programs like an image editor or word 
processor. 
 
3.5.14 Thumbnails Only View 
 
When there are many frames in a project it can be useful to switch to the Thumbnails 
Only view through the menu “View � Thumbnails Only” (or by double clicking/ 
pressing enter on one of the thumbnails in the sequence). Here you get an overview 
of the entire project and it is easier to edit the sequence of frames. It is also an easy 
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way to find a specific frame you want to edit. You return to the normal project view 
through the same menu option or double clicking/pressing enter on a thumbnail. 
 
In both the Thumbnails Only View and when the thumbnails list is active in normal 
project view you can easily navigate to another frame by just typing the number of 
the frame you want to see. 
 

3.6 Rendering the flash presentation 
 
To create a flash presentation use the menu “Project � Render”. If you haven't 
named the output file yet the Project Settings dialog will popup first for you to enter 
the name. Also if you have chosen to use a palette but haven't created one yet, the 
palette dialog will be shown for you to do this before starting to render.  
 
Rendering creates either a flash (.swf) file with a corresponding HTML file (in the 
same folder) or a windows executable (.exe) depending on your choice in the Project 
Settings. To view the presentation you can choose menu “Project � View Rendered 
Output”. 
 

3.7 Templates 
 
One of the advanced features of Wink is the option to create templates with many of 
the settings/properties that apply to a project. You can use templates to make 
consistent presentations with the same look without having to do the same 
customizations each time. 
 
Not all settings/properties can be saved in a template because some settings will 
seldom or never apply to all frames in a project or to more than one project. In the 
schema below you can see which items that can be saved or not saved. 
 

Items that can be saved Items that cannot be saved 
Background Image Title Text 
Frame Position Stay in this frame for time 
Title Enabled Cursor Enabled 
Title Font & Style Cursor Pointer 
Title Position Cursor Position 
Callout Next Button Enabled 
Textbox Font & Style Previous Button Enabled 
Next Button Position Goto Button 1 Enabled 
Previous Button Position Goto Button 1 Target 
Goto Button Positions Goto Button 2 Enabled 
Next Button Image Goto Button 2 Target 
Previous Button Image Textbox Enabled 
Goto Button Images Textbox Text 
Frame Rate Setting Textbox Position 
Use Palette Setting Actual Palette 
Cursor Movement Setting Output file name 

 



 25 

Templates are created based on the 
settings of a chosen frame in the 
project. So when you want to create a 
template you first have to find (or 
create) a frame with all the correct 
settings. Then use menu “Project � 
Save Template”. This opens the choose 
dialog where you select what items to 
save in the template. Press OK and a 
Save dialog will appear to specify the 
template file name. Templates are by 
default saved in the “Templates” 
subfolder in the Wink program folder. 
  
When you want to apply a template to a 
project (all frames) use the menu 
“Project � Apply Template”. This will 
show the Choose Template dialog. 
Choose a template file and see a 
preview of the current project with the 
selected template. You can scroll 
through all the frames in the current 
project with the scrollbar at the bottom. 
To select which template items to apply 
you can use the “Template Items” 
button. 
  
Note: All position items from a template are based on the size of the frame in the 
original project from which the template was created. So applying a template to a 
project with different frame size may not produce good results. If the size of the 
current project is smaller than the original project some elements might even be 
placed outside the viewable area. 
 

3.8 Export/import text to and from file 
 
All the text that you add to a project in textboxes and titles can be exported to and 
imported from text files. This provides an easy way to translate or just proof read 
projects by exporting all the text, translate/proof read it externally in a text editor and 
then import it back into the same project.  
 
If the changes you have made in the text file can’t fit in the project’s original textbox 
Wink will automatically resize the callout when you import the text. Though it can still 
be worthwhile to do a quick look over of the frames with textboxes afterwards to see 
if they still look fine. 
 
Note: If you decide to edit the text file in a word processor like Microsoft Word you 
have to save the document as plain text again. Otherwise Wink won’t be able to read 
it. 
 

3.9 Export to HTML, PDF, PostScript and image files 
 
Wink can export the project to HTML, PDF and PostScript files. This gives you an 
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easy way to present the subject to your end users in a format other than the flash 
presentation. For instance some users may want to print the presentation, which isn't 
possible with a flash file. If a HTML or PDF file is placed next to the flash 
presentation on a website the users have more options. 
 
The images in the exported file will look exactly like the frames in the project and the 
buttons will still work in all the formats.  
 
When exporting to HTML you have to 
choose the format used for images 
(the images are saved as separate 
files).  
  
The best image format for HTML files 
is PNG (for screenshots of programs). 
If any frames contain photos then use 
JPEG. 
 
Note: Use BMP, JPG or PNG formats 
if you want to be able to see the 
images in the HTML file. Use the other 
formats to export frames and use in 
other programs.  
 
For PDF and PostScript you have the 
option to decide the paper size and 
orientation for the export, while the 
option to “Fit Page to Image” is limited 
to PDF Export. You can also choose 
to not include buttons from the 
presentations if the exported 
document is going to be printed. 
 

 

3.10 Preferences 
 
Wink’s preferences can be found in the menu “File � Preferences” where you can 
specify some general settings for the program. There are also 2 options (preloader 
and control bar) that actually should be project specific settings and will be moved to 
project settings dialog in version 2.0. 
 
1. Thumbnail image size sets the maximum size the thumbnails can have (the 

thumbnails will maintain the aspect ratio as the screenshots). 
2. By default opening a Wink project from the file explorer while Wink already is 

running will open it in the current instance of Wink. You can change this setting to 
open a new instance instead. Remember you cannot drag-and-drop items 
between different instances of Wink. 

3. Wink will open the last used project at start-up but you can disable this action if 
you often open Wink to create new projects. 

4. Makes Wink save the project automatically before rendering. 
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5. Frame icons are small icons below the thumbnails that show details about that 
frame - if a value is specified in “Stay in this frame for time”, if any button is used 
and if a textbox has been added for each frame. These icons can be very useful 
to find the thumbnail/frame you want to edit. If both a value is specified in “Stay in 
this frame for time” and one or more button is used in a frame you will only see 
the button icon because the button overrides the “Stay in this frame for time” 
value. 

6. “Compress fast while capturing” improves capture efficiency while taking a little 
more memory. 

7. A preloader displays when the actual presentation is loading in a browser, so that 
the user knows that something is happening when loading big presentations. You 
can choose from the default preloaders or create your own. Editing a preloader is 
described in the next section. 

8. A control bar displays a progress bar in the flash output and lets the user both 
pause/play any time in the presentation and jump to any place by clicking on the 
progress bar (only in swf file). You can select one from the default set supplied 
with Wink or you can create you own. Editing a control bar is described later. 

9. The default hotkeys for each mode of capturing can be changed to what you 
want. (Some default windows hotkeys cannot be used.) 

10. Input-driven capture can capture all keystrokes except modifier keys (Alt, Control 
and Shift) used alone and Alt + Tab. Besides these keys you can add your own 
keys/key combinations that should be ignored. 

11. Specify a sound file to play when a captured screenshot is added to the project. 
12. By default Wink will use the system default browser to display flash 

presentations. If you want to use another browser specify the path here. 
 
3.10.1 Flash Preloader 
 
A flash preloader is displayed when the presentation is loading in a browser, so that 
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the user knows that something is happening when loading big presentations. You 
can choose from the default preloaders or create your own with menu File � 
Preferences � Choose Flash Preloader � Create New. 
 

 
 
A preloader can contain an image or colour background, a text label and a progress 
bar. 
 
At the top right of the Flash Preloader Editor you can choose a background image. If 
you don’t choose a background image the background colour right below will be used 
instead. Furthermore if the Text Label and/or Progress Bar are placed outside the 
area of the background image you will also see the background colour. 
 
You can enter position values or use the mouse to alter the placement of the Text 
Label directly in the work area. The content of the Text Label is the text entered in 
the Text String field and if wanted a percentage value showing how much of the 
presentation is currently loaded. In order to separate the text and percentage value 
you must simply press space a number of times after the actual text. The appearance 
of the text is defined by the size of the Text Label, the 3 different flash fonts and the 
colour of the text. 
 
The Progress Bar can be placed in the same way as the Text Label and consists 
basically of a coloured bar that can be smooth or split up into small blocks. This bar 
can also be surrounded by an outline that has a line and background colour.  
 
3.10.2 Flash Control bar 
 
A control bar displays a progress bar in the flash output and lets the user pause/play 
any time in the presentation and jump to any place by clicking on the progress bar 
(only in flash swf file). Like with the preloader a number of default control bars are 
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supplied with Wink and you can create you own through Wink’s preferences � 
Choose Flash Control Bar � Create New (Control Bar). 
 

 
 

There are two differences between the use of a control bar in a flash swf file and a 
self-executable exe file. In the swf file the play and pause button are overlaid each 
other since only one is relevant at a time depending on the fact if the presentation is 
currently playing or paused. It is also possible to click anywhere on the progress bar 
in an swf file to jump to this place in the presentation. An exe file is limited in these 
two cased as the play and pause buttons are placed separately and it is not possible 
to click the progress bar to jump to another place in the presentation. 
 
When editing (and choosing) a control bar you will see a preview displaying the two 
possible states regarding if the play or pause button is currently visible. As said 
above this preview is not correct if you render to an executable file where the two 
buttons will be placed beside each other. In the edit window you can choose between 
3 view modes displaying how the buttons will look when they are not touched, when 
the mouse cursor hovers over them and when the buttons are pressed down. 
 
The actual images used for all situations are chosen below. It is not necessary to use 
all types of images for a control bar, as you also will be able to see in the supplied 
default control bars. For the play and pause button you must supply an image for the 
Normal mode while the MouseOver and Pressed images are optional. Regarding the 
progress bar you would normally always use images for the Left, Right and Empty 
Middle parts while it is optional if you will use either (or both) of the Thumb and Filled 
Middle to show how far the presentation have come. 

3.11   Shortcut keys 
 

F3  Project Settings 
F4  Program preferences 

Ctrl + F4  Close project 
Alt + F6  Switch between thumbnail and work-area panes 

Ctrl + F6  Switch between open projects 
F7  Render Project 
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F3  Project Settings 
F8  View Rendered Output 

F12  Toggle Properties Bar 
Ctrl + F9  Export Text to File 

Shift + F9  Import Text from File 
Ctrl + A  Select all elements in a frame or select all frames 
Ctrl + F  Choose Textbox Font 
Ctrl + J  Current / Choose Frame 
Ctrl + L  Choose Callout 
Ctrl + N  New project 
Ctrl + O  Open existing project 
Ctrl + P  Edit Palette 
Ctrl + R  Choose Cursor 
Ctrl + S  Save project 
Ctrl + Y  Redo in Callout Editor 
Ctrl + Z  Undo in Callout Editor 

Insert  Insert Frames 
Delete  Delete 

Ctrl + X / Shift + Del  Cut 
Ctrl + C / Ctrl + Ins  Copy 

Ctrl + Shift + C  Copy Merged 
Ctrl + V / Shift + Ins  Paste 

Alt + Ctrl + �  First frame 
Alt + �  Previous frame 
Alt + �  Next frame 

Alt + Ctrl + �  Last frame 
Alt + X  Exit program 

 

3.12 Toolbar 
 
Here is a list of all the icons in Wink’s toolbar and what they do. 
 

 Create a new project 
 Open an existing project 
 Save the active project 
 Wink preferences 
 Delete the current selection 
 Cut the current selection and put it on the Clipboard 
 Copy the current selection and put it on the Clipboard 
 Paste Clipboard contents 
 Move to the first frame in the sequence 
 Move to the previous frame in the sequence 
 Move to the next frame in the sequence 
 Move to the last frame in the sequence 
 View/modify the palette for the current project 
 View/modify settings for the current project 
 Render the presentation from this project with the given options 
 View the rendered presentation 
 Displays the license and other information about Wink 
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4   

4.1 Screen size of presentations 
 
When creating presentations you should think about what screen resolution the end 
users are likely to use. If the user views the flash file inside the browser they won't be 
able to see the entire area if the flash file is the same size as the end users screen 
resolution. Also the taskbar takes up some screen space. Therefore you should 
always be sure to record the presentation in a smaller size than the screen resolution 
the targeted users are likely to use. 
 
For instance if you make a presentation based on the entire screen size and you 
know that the end users are like to use a screen resolution of 1024*768, then set 
your screen resolution (temporarily) to 800*600 when doing the capture. Afterwards 
when editing inside Wink you can return to the normal (larger) resolution because 
then you will be able to see the entire (or at least most of the) area of each frame, 
which makes it easier to edit the project. 
 
You also have the option to resize a project to a smaller area size. But this will also 
give the presentation a slightly blurred look because it is not possible to keep the 
images as sharp as the original screenshots. 

4.2 Optimal use of input-driven capture  
 
To get the best result from input-driven capture you should work slow doing the 
actions that should be recorded since Wink might not be able to keep up with you. 
This does depend on both the size of the area you are capturing and the speed of 
your computer.  
 
If the last action (mouse click) you have done with the mouse requires some 
processing from the PC and there is a delay before the screen is updated, Wink will 
miss a screenshot when the screen is updated. You can take a manual screenshot of 
this step before processing with the next actions. 
 
Finally when recording typing or other situations where the blinking text caret is 
visible you will record extra frames because Wink will keep the screenshots even 
though the only difference between frames is the text caret. To avoid this you can set 
the text caret to not blink and always be visible through a Windows setting. In 
Windows XP this setting is in the accessibility options while it is placed under the 
keyboard properties on Windows 2000. These redundant frames could also be 
deleted in Wink when editing the project afterwards but it is easier to not record them 
in the first place. 

4 TTIIPPSS  AANNDD  TTWWEEAAKKSS  
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4.3 Edit multiple frames 
 
One of the cool features of Wink is that you can edit the properties of multiple frames 
simultaneously. If you select more than one frame/thumbnail in the sequence the 
options changed in the properties bar apply to all frames. So you can change the 
textbox font used in all marked frames and even more interesting when using the 
advanced properties bar it is possible to align the position of, for instance, the Next 
button across all selected frames by editing the position values in the properties bar. 

4.4 Insert image files into frames 
 
You can insert normal image files into frames in Wink by opening the images in an 
image browser or paint program, copy the image to clipboard inside this program and 
then paste it into a frame in Wink. So if you have captured some screenshots in 
another program it will be possible to insert this into a Wink project and you can also 
use non-screenshot images like photos. 

4.5 How to create more than one textbox in a frame 
 
Normally a frame can have only one textbox but it is possible to achieve the effect of 
having two or more textboxes by using the Copy Merged option (even though only 
one textbox will be editable). 
 
To do this you must select the frame that you would like to have two (or more) 
textboxes in, temporarily disable all elements except the textbox, choose menu “Edit 
� Copy Merged”, paste the new image into the same frame and enable the 
previously disabled elements. Then move the textbox and you should now see a 
copy of it below the original. The copy cannot be changed because it is part of the 
image. But the original textbox can be edited as needed and you achieve the effect of 
having two textboxes. To get even more textboxes you will just have to repeat this 
procedure. 
 
Be aware that if you are currently using a background image/colour in the project you 
will have to remove the background image/colour temporarily and add it again 
afterwards. 

4.6 Copy frames between projects 
 
You can open more than one project simultaneously in Wink and copy (or drag-and-
drop) frames between projects. This way if you have created a project but you forgot 
to take some more screenshots you can create the remaining screenshots in a new 
project and copy these frames to the old project. 

4.7 Optimize the size of presentations 
 
To optimize the file size of presentations you should clean your desktop before 
capturing screenshots. This also has the advantage that the end users watching the 
presentation won't be distracted by other things you might have installed on your 
computer. Some of the things to clean up are: 
 

• Remove unnecessary icons from the desktop (copy them to a folder to easily 
get them back). 
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• Disable wallpaper and use a single colour on the desktop. 
• In Windows XP set the theme to “Windows Classic” instead of the default 

“Windows XP”. 
• Set the title bar of windows to a single colour instead of the default gradient. 
• Disable the Quick Launch toolbar. 
• Close all non-relevant programs (also in the system tray). 

 
If you won't be showing the desktop or taskbar in the presentation some of these 
suggestions obviously aren't necessary. 
 

4.8 Maximize the space for showing presentations in a 
browser 

 
To be sure that the end users can see the entire (or at least most of the) presentation 
area you can disable all the elements that usually appears in the browser like the 
toolbar, address bar, status bar etc. using JavaScript to open the browser window. 
 
If you have a webpage from which the Wink-generated presentations are showed, 
add the following script code somewhere inside the <head></head> element of that 
webpage’s html source. 
 

 
<script> 
function WinkPresentation(file) 

{ 
    window.open(file,'Wink','resizable=1,scrollbars=1'); 

} 
</script> 
 

 
The actual link that will open the html file with the presentation must be added inside 
the <body></body> element of the html source. For example: 
 
 

 
<a href="javascript:WinkPresentation('sample.htm');"> 
    Show sample presentation 
</a>  
 

 
In the example above “sample.htm” must be replaced with the name of the html file 
generated by Wink and ”Show sample presentation” should be replaced with the text 
you want the user to see in the homepage describing the presentation. 

4.9 Saving compressed projects 
 
Wink projects can take a lot of space if they have a large number of frames, since all 
of them are image/video data. When you have finished a project or if you want to 
send a project to a friend, it is a good idea to save the project using the “File � Save 
compressed” menu option. This will compress the project and save. Compressed 
projects typically occupy 4 times to 20 times less space than normal projects. You 
can compress them further using any zip utility. 
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Compressing projects and loading compressed projects take a significant time, so 
use this only when necessary. All samples distributed with Wink are compressed 
projects. 

4.10 Editing callouts outside Wink 
 
The callouts used in Wink are actually SVG images that can be found in the callout 
subfolder below Wink’s program folder. So besides editing callouts inside Wink you 
can also edit them with any drawing program that support this image format. 

4.11 URLs of interest 
 
DebugMode homepage – http://www.debugmode.com/ 
Wink homepage – http://www.debugmode.com/wink/ 
DebugMode User Forums – http://www.debugmode.com/forums/ 
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5   

5.1 Buttons in PDF files exported from Wink 
 
When using Continuous view in Adobe Reader all buttons in a PDF file exported 
from Wink will go to the page/frame after the actual frame they should go to. The 
buttons work correct when Adobe Reader is setup to the default Single Page view. 
This is an issue with Adobe Reader and not Wink and hopefully will be corrected in 
future releases of Adobe Reader. 
 

5.2 Flash output sometimes looks garbled with palette 
 
This is due to a bug with the Flash player. You can either render the flash output 
without a palette, or create another palette with a different number of colours to work 
around this bug. 
 

5 KKNNOOWWNN  IISSSSUUEESS  


